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About this document

The following topics are discussed in this section:

• “Who should read this document and why” (page 9)

• “How this document is organized” (page 9)

• “What’s new in this document” (page 10)

• “Text conventions” (page 10)

• “Related documents” (page 11)

Who should read this document and why
Use this document if you are an operator and new to using the Preside 
Multiservice Data Manager (MDM). This document provides a summary of 
both Preside MDM user interfaces: MDM Toolsets and Operator Client. 
Basic startup procedures are also provided.

What you need to know
This document assumes that you have never used the MDM Toolset or 
Operator Client to start Preside Multiservice Data Manager (MDM) and that 
you are not familiar with product interfaces.

How this document is organized
This document contains the following sections:

• “Basic procedures” (page 13) provides basic startup procedures

• “MDM interfaces” (page 33) describes the FCAPS menu as it used in the 
MDM Toolset environment and Operator Client environment.
Preside Using MDM Toolset and Operator Client Interfaces     15.1RSUP
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• “Tool and environment support” (page 53) provides a quick reference to 
tool support in both the MDM Toolset environment and Operator Client 
environment.

What’s new in this document
This is a new document.

Text conventions
This document uses the following text conventions: 

• nonproportional spaced plain type

Nonproportional spaced plain type represents system generated text or 
text that appears on your screen.

• nonproportional spaced bold type

Nonproportional spaced bold type represents words that you should type 
or that you should select on the screen.

• italics

Statements that appear in italics in a procedure explain the results of a 
particular step and appear immediately following the step.

Words that appear in italics in text are for naming.

• [optional_parameter]

Words in square brackets represent optional parameters. The command 
can be entered with or without the words in the square brackets.

• <general_term>

Words in angle brackets represent variables which are to be replaced with 
specific values.

• UPPERCASE,lowercase

Uppercase and lowercase letters that appear in UNIX commands and 
parameters must be matched exactly. The system matches upper and 
lowercase characters differently.
241-6001-122   15.1RSUP   
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• UPPERCASE,lowercase

Passport commands are not case-sensitive and do not have to match 
commands and parameters exactly as shown in this document, with the 
exception of string options values (for example, file and directory names) 
and string attribute values.

• ->

A right-pointing arrow in a procedure indicates that a menu item has 
submenus from which you must choose. The appropriate submenu 
selection is shown immediately after the arrow. 

• |

This symbol separates items from which you may select one; for 
example, ON|OFF indicates that you may specify ON or OFF. If you do 
not make a choice, a default ON is assumed.

• ...

Three dots in a command indicate that the parameter may be repeated 
more than once in succession.

The term absolute pathname refers to the full specification of a path starting 
from the root directory. Absolute pathnames always begin with the slash ( / )
symbol. A relative pathname takes the current directory as its starting point, 
and starts with any alphanumeric character (other than /).

Related documents
See the following document for related information:

• 241-6001-801 Preside MDM Overview
Preside Using MDM Toolset and Operator Client Interfaces     15.1RSUP
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Chapter 1
Basic procedures

This section includes procedures for starting and stopping the Preside MDM 
using the MDN Toolset or Operator Client as well as for changing passwords 
and troubleshooting.

Navigation
Operator Client

• “Starting Operator Client” (page 14)

• “Customizing the Netscape web browser” (page 21)

MDM Toolset Startup
• “Starting a local MDM session” (page 22)

• “Starting a remote session on trusted workstations” (page 24)

• “Starting a remote session on non-trusted workstations” (page 26)

• “Ending an MDM session” (page 28)

Changing centrally authenticated passwords
• “Changing centrally authenticated passwords in MDM Operator Client” 

(page 29)

• “Changing centrally authenticated passwords via Sun ONE IS website” 
(page 30)

Troubleshooting
• “Troubleshooting” (page 31)
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14   Chapter 1 Basic procedures
Starting Operator Client
Use this procedure to launch the Operator Client application from your 
Solaris workstation or from your Windows-based personal computer.

Prerequisites
• The Operator Client has an ethernet connection to an MDM User 

Administration Server (UAS).

If the network connection between the Operator Client and the MDM 
User Administration Server includes a firewall, ports on the MDM may 
require configuration to enable access. For more information, see 
241-6001-310 Preside MDM Server Reference Guide.

• You must know the IP address or the node name of your User 
Administration Server.

• A user identity has been created in the User Administration System by 
the Administrator. The user is configured to launch the MDM 
applications based upon their assigned permissions.

Procedure steps
1 If the Operator Client is a PC,

a. using WordPad, edit the PC file 
c:\WINNT\system32\drivers\etc\hosts to identify the MDM 
workstations on which the fault or configuration management servers 
exist. For each of the MDM workstations, add the following 
information: IP address, hostname, fully qualified hostname.

For example,

47.123.234.34 mysun mysun.lab.nortel.com

b. Close and save the file c:\WINNT\system32\drivers\etc\hosts.

2 In the address or location field of a web browser window, enter:

http:// <administration server name>:8080/UI

The JWS auto-download feature is disabled through the MDM JNLP file. 
If the workstation or PC does not have the proper JRE version, an error is 
displayed indicating the version of JRE needed to run Operator Client. 

Note:  Operator Client does not try to auto-download the JRE from SUN.
241-6001-122   15.1RSUP   
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Depending on your environment, one of the following Operator Client 
Launch windows open.
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3 Make a selection from the table.
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4 If this Operator Client is a PC, click Download Windows 32-bit JRE 
installer. 

If this Operator Client is a UNIX workstation, click Download Solaris 8 
32-bit JRE installer or click Download Solaris 8 64-bit JRE extensions 
installer.

Note:  For UNIX workstation users, your Administrator can indicate which 
JRE installer to use.

The File Download dialog opens.

5 Click Save.

6 Run the jre executable (xxx.exe) to Install the JRE software.

If you are installing Operator Client on a PC, a dialog opens asking if you 
want a desktop icon for quick launch. Make an appropriate choice.

7 Click LAUNCH on the Operator Client launch menu.

Starting Operator Client Destination 

for the first time step 4

after a Windows or Solaris 
installer has been down loaded

step 7
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The Java Web application starts. A progress Java Web Start dialog 
opens. 
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When complete, the Operator Client Login window opens.

8 Enter your User Name and Password and click Login.

When your User Name and Password are authenticated, the Operator 
Client window opens. The menus and commands available on and from 
the Main Menu bar are determined by access control setup files on the 
User Administration server. For more information, see NN10600-605 
Passport - MDM Network Security: Operations. 
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To change user preferences, see 241-6001-301 Preside MDM 
Customization Administrator Guide. 

9 Select tools as required from the main menu.
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Customizing the Netscape web browser
If Operator Client is using the Netscape web browser, use this procedure 
before using Operator Client applications.

Prerequisites
• “Starting Operator Client” (page 14)

Procedure steps
1 Launch Netscape.

2 Select Edit -> Preferences.

The Preferences dialog opens.

3 Click Navigator -> Applications.

4 Click New Type...

5 In the Description of type field, type jnlp file.

6 If this MDM Operator Client is on a PC, in the File extension field, type 
jnlp.

7 If this MDM Operator Client is on a UNIX workstation, in the Suffix field, 
type jnlp.

8 In the MIME Type field, type application/x-java-jnlp-file.

9 For Application to use, click Browse and select the Java Web Start (JWS) 
executable.

10 On a UNIX workstation, select 
/opt/nortel/3rdparty/java/current_JRE/javaws/javaws 
%s
For Netscape version 7.0 and later, the %s parameter is not required.

On a PC, select 
c:\Program Files\Java\j2re1.4.2_02\javaws\javaws.exe 
%s.
For Netscape version 7.0 and later, the %s parameter is not required.

11 Click OK to close the New Type dialog.

12 Click OK to close the Netscape Preferences dialog.
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Starting a local MDM session
Use the procedure in this section to start a Preside Multiservice Data Manager 
(MDM) session on a local workstation and to open a Preside MDM window.

Use this procedure if you have accidentally exited from the MDM Toolset 
menu and want to start a new session without having to login again.

You do not need to use the information in this section to start a local Preside 
MDM session if the UNIX user account is one of the following items:

• an existing account to which the default Preside MDM user environment 
has been added. For these accounts, the session starts automatically and 
a Preside MDM window opens when you log in.

• a new user account that is created to run the default Preside MDM user 
environment. For these accounts, the session starts automatically and a 
Preside MDM window opens when you log in. 

• an RNCS user account. For these accounts the user environment is set up 
to allow you to access the network through RNCS.

Prerequisites
Before performing the following procedure, ensure that you have sourced the 
Preside MDM user environment by entering commands, or by modifying the 
user account’s set-up files.

Procedure steps
1 Open a Preside MDM window by

/opt/MagellanNMS/bin/nmstool \
[Motif resource parameters] [toolset file] &

where:

[Motif resource arguments]

are used to specify Motif resources and X-command line arguments such 
as the size of the Preside MDM window and its location on the screen. For 
example, -geometry +0+0.

[toolset file]

is the filename or the full pathname of a toolset definition file. A toolset 
definition file specifies the set of Preside MDM tools that a user may 
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access at login. For descriptions of the toolset definition files provided with 
the MDM software, see 241-6001-301 Preside MDM Customization 
Administrator Guide.

If you omit this parameter, the toolset file specified in the set-up files by 
the value of environment variable NMSTSETS is used. The default value 
of this variable is the English language toolset Full.tsets. 

This toolset file provides access to all Preside MDM tools except those 
intended for an administrator. For an administrator (root account) enter 
Admin.tsets for this parameter.

You can also create your own toolset definition files. For the instructions 
to customize the toolset menus, see 241-6001-301 Preside MDM 
Customization Administrator Guide.

The copyright dialog opens.

2 Click OK.

The copyright dialog closes.

The Preside MDM window opens.
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Starting a remote session on trusted workstations
Trusted workstations are workstations that allow remote login to occur 
without security checks. They must be trusted because the remote shell 
command (rsh) is used to invoke the remote session. 

To configure workstations as trusted, you must add information about the 
hosts to files /etc/hosts.equiv and/or <home directory> /.rhosts file(s). For 
information on this procedure, refer to the man pages for hosts.equiv and rsh.

Prerequisites
• the workstations are running Preside MDM

• the local workstation is running X-Windows

• the two workstations are linked by a TCP/IP connection (including over 
Ethernet, Token Ring, IP over WAN)

• the user account must be shared through NFS or cloned (same user name, 
ID, and environment) between the two workstations

• You can only run one Preside MDM session and open a Preside MDM 
window for a given user-session (for a given DISPLAY variable and 
value). 

• From a given terminal window or console, you can run only one Preside 
MDM session per workstation, including remote workstations.

Procedure steps
1 Enter the following command:

/opt/MagellanNMS/bin/nmstool \
-host <remote hostname> \
[-user <remote user>] ...\
[Motif resource parameters] \
[toolset file] &

where:

<remote hostname>
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is the hostname of a remote workstation on which you wish to run the 
Preside MDM tool. If you omit this parameter, the workstation is assumed 
to be this workstation (localhost).

<remote user>

is the remote user account name. You can use this option when the 
remote user account name to use is different from the current name.

Note:  Similar remote Preside MDM sessions can be established by 
selecting System -> Utilities -> Remote Access.
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Starting a remote session on non-trusted workstations
Use the following procedure to start a remote session if the workstations are 
not trusted, or if you need to log into a remote workstation from a different 
user account than the one on the local workstation.

Prerequisites
• the workstations are running Preside MDM

• the local workstation is running X-Windows

• the two workstations are linked by a TCP/IP connection (including over 
Ethernet, Token Ring, IP over WAN)

• the user account must be shared through NFS or cloned (same user name, 
ID, and environment) between the two workstations

• You can only run one Preside MDM session and open a Preside MDM 
window for a given user-session (for a given DISPLAY variable and 
value). 

• From a given terminal window or console, you can run only one Preside 
MDM session per workstation, including remote workstations. 

Procedure steps
1 Enter the following command to allow information generated on the 

remote workstation to be displayed on the local workstation:

xhost +<remote host name>

2 Log in to the remote workstation by using rlogin or telnet.

3 Enter the following command while logged in:

/opt/MagellanNMS/bin/nmstool -display \
<local display> \
[<Motif arguments>] \
[<toolset>]

where:

<local display>

is the value of the DISPLAY environment variable for the local workstation 
[not the variable for the remote Preside Multiservice Data Manager 
(MDM) session.
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Example:

To set up a remote session on workstation MDM 1 for workstation MDM 
2, first remote login in to MDM 2, then enter: /opt/MagellanNMS/bin/
nmstool -display NMS1:0.0

4 When the session is over and you have logged out, enter the following 
command to prevent any more information generated on the remote 
workstation from being displayed on the local workstation:

xhost -
Preside Using MDM Toolset and Operator Client Interfaces     15.1RSUP
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Ending an MDM session
To end an active Preside Multiservice Data Manager (MDM) session, from 
the Preside MDM window, select File -> Exit.

For remote sessions, the Preside MDM window, the corresponding mdm 
session, and the remote connection are terminated. 

For local sessions, the mdm session remains active until you log out.

While the mdm session is still active, the connections to the network are 
preserved, and you can open another Preside MDM window without re-
establishing these connections.
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Changing centrally authenticated passwords in MDM 
Operator Client

Change the password for your centrally authenticated userid when it has 
expired or when you require a new password. Users of MDM Operator Client 
change their centrally authenticated passwords in the Operator Client 
interface. 

Prerequisites
• The user must have access to the Security-User category of applications.

Procedure steps
1 Login to the MDM Operator Client.

If your password has expired, the Password Expiration dialog opens.

2 If your password has expired, click Change Password otherwise, from 
the System, menu, click Security->Change Password.

3 The Change Password application opens.

4 Enter your current password.

5 Enter your new password.

6 Confirm your new password.

7 Click OK.
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Changing centrally authenticated passwords via Sun ONE 
IS website

Change the password for your centrally authenticated userid via the Sun ONE 
IS web url. Users who do not have access to MDM Operator Client, change 
their centrally authenticated passwords via the Sun ONE IS website.

Prerequisites
• The user must have access to the Sun ONE IS.

Procedure steps
1 Access one of the following urls:

• http://<host.domain>:58080

• https://<host.domain>: 58081 (if using SSL to encrypt data)

2 Follow the on-screen instructions.
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Troubleshooting
The following table describes possible error messages during authentication.

Table 1
Authentication errors

Error Description

Application cannot be 
launched without proper 
authentication

You have attempted to launch an application without initially 
authenticating.

Access denied, see your 
system administrator

You have attempted to launch an application for which you do not 
have the proper authentication privileges.
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Chapter 2
MDM interfaces

The Preside Multiservice Data Manager (MDM) interface operates in two 
environments—MDM Toolset and Operator Client. The MDM Toolset 
environment supports both administrator and operator tasks. The Operator 
Client environment provides a subset of MDM tools for operator tasks. 

Navigation
• "MDM Toolset interface" on page 33

• "MDM Operator Client interface" on page 38

• “Dialog boxes” (page 43)

MDM Toolset interface
The MDM Toolset environment provides a user-friendly graphical user 
interface with color graphics, menus, icons, help screens, online 
documentation, and multiple windows. Multiple windows allow operators to 
run several applications at the same time.

When you start MDM in the MDM Toolset environment, the MDM Toolset 
main window opens on your workstation.
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Preside MDM window

As shown in Figure  2 the MDM Toolset window is composed of the 
following parts:

• "Menu bar"

• "FCAPS menus"

Menu bar

FCAPS menus
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Menu bar
The menu bar at the top of the window consists of the following menus:

• "File menu" 

• "Options menu" 

• "Help menu" 

File menu
The only command that is available from the file menu is the Exit command. 
The Exit closes the MDM Toolset window.

Options menu
Table 2 lists and describes the commands available from the Options menu.

Table 2
Options menu commands

Command Description

Fonts Allows you to select the font for all MDM tools. 
After you select a font, all tools launched will start 
with the selected font. The font remains in effect 
until you select another font. If you do not select 
a font, there is no font requirement set on the 
applications
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Help menu
Table 3 lists and describes the commands available from the Help menu.

Applications use private 
color maps

lets you select private or default color maps for 
Preside Multiservice Data Manager (MDM). 
When you enable the Applications use private 
color maps menu item, all other applications start 
with private color maps. Because the default 
color maps of some applications use many 
colors, this option gives you control over which 
applications receive color. (Some of the MDM 
applications use color to identify state.) If you do 
not enable this menu item, MDM uses system 
default color maps.

Allow CDE session 
workspace management

lets you select Common Desktop Environment 
(CDE) as the session manager where all 
applications launch. When you use CDE, all 
applications that were running when you logged 
off launch when you log in. CDE also saves the 
positions, sizes, and argument lists of 
applications. If you do not enable this menu item, 
applications can use another session manager

Table 3
Help menu commands

Command Description

On Window displays online help information about any object 
in the window.

On Context provides a description of the window.

Table 2
Options menu commands

Command Description
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FCAPS menus
The FCAPS menus are a set of cascading menus from which you can launch 
the MDM tools to perform network management tasks. For an overview of the 
tools in each tool menu, see 241-6001-801 Preside MDM Overview.

Table 4
MDM Toolset FCAPS menus

Tool menu Description

Fault Provides commands for starting tools related to 
fault management.

Configuration Provides commands for starting tools related to 
the configuration of nodes and services.

Accounting Provides a command for starting tools used to 
collect accounting information.

Performance Provides command for starting tools used to 
collect data related to performance 
management.

System Provides four submenus: Administration, 
Security, Utilities and Custom.
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MDM Operator Client interface
The MDM Operator Client environment provides a user-friendly graphical 
user interface with color graphics, menus, icons, help screens, online 
documentation, and multiple windows. Multiple windows allow operators to 
run several applications at the same time.

The MDM Operator Client is launched from either a PC or a UNIX 
workstation with Netscape or Internet Explorer.

Commands for starting the tools supported by MDM Operator Client are 
selected from menus accessed from the main window menu bar.

MDM Operator Client main window

The MDM Operator Client main window is composed of the following parts:

• "Menu bar" 

• "Display area" 

Menu bar
The Menu bar at the top of the window consists of the following menus:

• "File menu" 

• "Fault menu" 

• "Configuration menu" 

• "Performance menu" 

• "System menu" 

• "Window menu" 

• "Help menu" 

Menu bar

Display area
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File menu
Table 5 lists and describes the commands available from the File menu.

Fault menu
This menu provides commands for starting tools related to fault management. 
See 241-6001-801 Preside MDM Overview for an overview of the tools in this 
menu.

Configuration menu
This menu provides commands for starting tools related to configuration 
management. See 241-6001-801 Preside MDM Overview for an overview of 
the tools in this menu.

Table 5
File menu commands

Command Description

Exit Closes the Operator Client main window

Table 6
Fault menu commands

Command Description

Alarm Display Launches the Alarm Display tool.

Alarm Help Launches the Alarm Help tool.

Network Browser Launches the Network Browser tool.

Network Status Bar Launches the Network Status Bar tool.

Component Information Launches the Component Information tool.

Passport Shelf View Launches the Passport Shelf View tool.

MPE Shelf View Launches the MPE Shelf View tool.
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Performance menu
This menu provides commands for starting tools related to performance 
management. See 241-6001-801 Preside MDM Overview for an overview of 
the tools in this menu.

System menu
This menu provides three submenus: Administration, Security and Utilities. 
See 241-6001-801 Preside MDM Overview for an overview of the tools in 
these menus.

Table 7
Configuration menu commands

Command Description

Passport Nodal 
Provisioning

Launches the Passport Nodal Provisioning tool.

Passport Nodal 
Provisioning Template 
Editor

Launches the Passport Nodal Provisioning 
Template Editor tool.

MPE Nodal Provisioning Launches the MPE Nodal Provisioning tool.

Table 8
Performance menu commands

Command Description

Data Viewer Launches the Data Viewer tool.
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Window menu
Table 10 lists and describes the commands available from the Window menu.

Help menu
Table 11 lists and describes the commands available from the Help menu.

Table 9
System menu commands

Command Description

Administration Launches the following tools: 
- Service Selection - User Specific 
- Log Browser 

Security Launches the following tool: 
- Change Password 

Utilities Launches the following tools: 
- Operational Commands
- Command Console
- Remote Telnet Access
- Online Documentation

Table 10
Window menu commands

Command Description

Close window Closes the window.

Cascade Positions multiple windows diagonally starting at 
the top left corner.

Tile Horizontally Positions multiple windows in a left to right, then 
top to bottom configuration.

Tile Vertically Positions multiple windows in a top to bottom 
then left to right configuration.

Tile Positions multiple windows side by side.
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Display area
Tools that are currently running are shown in the Display area of the window. 
More than one tool widow can be displayed at one time.

Table 11
Help menu commands

Command Description

About Provides version information about the 
applications launched inside of the Operator 
Client desktop.
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Dialog boxes
The following dialog boxes are common to the MDM Toolset and Operator 
Client environments. Depending on the tool that 

• “Group Authentication” (page 43)

• “Device Selection” (page 44)

Group Authentication 
The Group Authentication dialog box lets you access a group of network 
elements. To authenticate, you need to specify the group name and its 
associated user ID and password. 

Depending on the defined preferences and previous authentication activities, 
the dialog box opens with entries in the fields. If it is a new session in MDM 
Toolset, the default entries reflect the login user id used to start the session. If 
it is a new session in Operator Client, the default entries reflect the desktop 
login user id used to start the session.

You can accept these values or, if needed, replace the values. See the table 
“Group Authentication dialog box components” (page 44) for details about 
the dialog box.

See the figure “Group Authentication dialog” (page 43).

Group Authentication dialog
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Device Selection
Use the Device Selection dialog box to specify the network device that you 
want to access. The Device Selection dialog box is common to several MDM 
tools and its behavior differs slightly depending on the MDM tool that opens 
the dialog box. 

Table 12
Group Authentication dialog box components

Dialog box 
component

Action 

Group Name box Select a group name from the field’s drop-down list. 
The list contains the group names associated with 
the device that was specified in the Device Selection 
dialog box.

User ID box The field may contain an entry. If the entry is not 
appropriate, you can change it. Type, or select from 
the drop down list, an appropriate user ID. The drop-
down list contains those user IDs that have been 
successfully authenticated and are available from 
the cache during the MDM session.

Password box Type the appropriate password in this field.

Command buttons:

OK Click OK to start the authentication process. If the 
authentication is successful, the dialog box closes. 
If authentication fails, a message displays in the 
message area of the dialog box. 

Cancel Click Cancel to cancel the authentication and close 
the dialog box.

Help Click Help to display online information in a Web 
browser.

Message area The message area displays status messages during 
the authentication process. If the authentication 
fails, a message indicating an authentication failure 
displays in the message area along with a Details 
button. Click the Details button for more information 
about the reason for failure.
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There are two parts to the dialog box. The first part is the Device Name panel. 
This panel lets you specify a device or search for a device in your network. 
The second part is the Device Search panel. This panel opens only when you 
click the Search button in the Device Name panel. Use this panel to search for 
devices based on search patterns. Depending on the MDM tool that opens the 
dialog box, you might see:

• the full Device Search panel. This occurs when an MDM tool has its own 
field for Device Name and an associated Search button, for example, 
Data Viewer. 

• the Device Name panel and Device Search panel both contained within a 
single window, for example, Nodal Provisioning.

See the figure “Device name search dialog” (page 46).
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Device name search dialog

Device Name panel
See the table “Device Name dialog components” (page 47) for details about 
the Device Name dialog.

Note: Device name input is ordinarily requested from the Device Name 
dialog, however, some tools, such as Data Viewer, have device name 
selection embedded in the main tool panel. The operation of the Device 
Name, whether it is in a dialog or in the main panel, is the same and is 
described in the following table.
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Device Search panel
The Device Search panel opens when you click the Search button in the 
Device Name panel. See the table “Device Search panel components” 
(page 48) for details about the Device Search panel.

Table 13
Device Name dialog components

Dialog box 
Component

Action 

Device Name box Type a device name or select an entry from the 
drop-down list. 

Search button Click the Search button to open the Device Search 
panel where you search for device names using 
search patterns and wildcards (*). Using the Search 
button is more efficient when your network contains 
a large number of devices because it avoids 
scrolling through a large number of entries in the 
Device Name drop-down list.

Command buttons: Command buttons are available only when the 
Device Name panel and Device Search panel have 
their own separate windows.

OK Click to activate the device selection and close the 
dialog box.

Cancel Click to cancel the device selection and close the 
dialog box.

Help Click to display online information in a Web browser.
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Table 14
Device Search panel components

Dialog box 
Component

Action 

Search Criteria:

Device Name box Specify the search pattern for retrieval. You can use 
wildcards (*) in this box.

Max Num to 
Retrieve box

Limit the number of devices to retrieve. The default 
value is 100 devices.

Search button Click this button to initiate the search for the device, 
or devices, based on the specified search criteria. 
The results of the search display in the Search 
Results list.

Search Results:

Device Name list This list displays the results of the search. Click on 
an entry in the list to select a device.

Command buttons:

OK Click to populate the Device Name panel with the 
selected entry in the Search Results list.

Cancel Click to cancel the device search and close the 
dialog.

Help Click to display online information in a Web browser.
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Chapter 3
Common Tools Functionality

This section describes the Preside Multiservice Data Manager (MDM) 
common tools.

Navigation
• “Version information” (page 49)

• “Context” (page 49)

• “Start Tool” (page 50)

Version information
The Preside Multiservice Data Manager (MDM) version is specified in the 
About Preside Multiservice Data Manager dialog available from the Help 
menu in Operator Client. The version number in MDM toolset is specified to 
the left of the screen below the main menu.

Context
Context lets you pass values among those Preside Multiservice Data Manager 
(MDM) tools that support context. Values are shared through the use of the 
MDM Context Server. 

The Put context command puts an item of information into a context buffer, 
and the Get context command takes the information from the buffer. By using 
the context commands, you can avoid some repetitive data entry work. The 
context buffer, however, can hold only one item of information at a time. 
Terminating a tool does not erase the contents of a context buffer; the buffers 
are erased when you log off.
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Start Tool
Several surveillance tools support a Start Tool menu. The purpose of this 
menu is to integrate tool and utility launching points in Preside Multiservice 
Data Manager (MDM). So, from one tool you can start other tools and 
utilities. 

The tools and utilities that you can start may vary depending on several 
factors. Such factors include the type of devices in the network, the tool from 
which you select the Start Tool command, and whether the Start Tool menu 
has been customized at your installation. 

When you select the Start Tool command, a menu opens and displays a list of 
tool categories. Each category supports a selection of tools and utilities that 
you can start. The following list details all MDM Start Tools categories and 
their associated tools and utilities. Based on the software installed at your 
organization, you may not see the complete list.

• Fault

— Component Information Viewer

— Circuit Viewer

— Acknowledge Alarms on Component

— Unacknowledge Alarms on Component

— Alarm Help

• Configuration

— Component Provisioning 

— Network Configuration System (NCS)

— Nodal Provisioning

— Service Provisioning 
-SPVC
-SPVP
-Trunk
-VCC Bearer Service
-VPC Bearer Service
-CES over PVC
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-CES SVC
-Frame Relay

— DPN Component Provisioning

— Network Reporting System
-Configuration Reports
-Configuration Differences

— Web Configuration

— PP4400 Component Provisioning

— Passport/SNMP Data Backup/ Restore

• Performance

— Data Viewer

— DPN Performance Viewer

• Utilities

— Customer Data

— Operator Commands

— Command Console

— Remote Telnet Session

— MIB Browser

For details on customizing the Start Tool menu, see 241-6001-301 Preside 
MDM Customization Administrator Guide. For a general description of these 
tools, see 241-6001-801 Preside MDM Overview.
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Appendix
Tool and environment support

Tools and utilities
Table 1 provides a list of all MDM tools and utilities and indicates which tools 
and utilities are available in the MDM Toolset and MDM Operator Client 
environments. 

Table 15
MDM tools and utilities in MDM Operator Client and MDM Toolset

Tool/Utility Operator Client MDM Toolset

Network Viewer no yes

Network Browser yes no

Passport Shelf View yes yes

MPE Shelf View yes yes

VPN Monitor no yes

Alarm Display: Active yes yes

Alarm Help yes yes

Network Status Bar yes yes

Component 
Information Viewer

yes yes

Query Historical 
Alarms

no yes
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Component Status 
Display

no yes

IP Discovery no yes

Circuit Viewer no yes

HP OpenView NM no yes

Nodal Provisioning yes yes

Embedded Nodal 
Provisioning

yes yes

Component 
Provisioning

no yes

Service Provisioning no yes

Data Synchronization 
Administration

no yes

Passport Backup and 
Restore

no yes

Software Download 
and Configuration

no yes

Network Activation no yes

ATM Traffic 
Management Profile 
Editor

no yes

Network Reporting 
System

no yes

Inventory Reports no yes

Passport Global Data 
Manager

no yes

Web configuration no yes

Data Synchronization 
Administration

no yes

Table 15
MDM tools and utilities in MDM Operator Client and MDM Toolset

Tool/Utility Operator Client MDM Toolset
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Passport/SNMP 
Service Data Backup/
Restore

no yes

Global Data Manager 
tool

no yes

Service Data Backup no yes

Service Data Restore no yes

Software Distribution no yes

Software Substitution no yes

Service Data 
Conversion

no yes

Envelope Editor no yes

Network Activation no yes

Template 
regeneration

no yes

MCF Directory Merge no yes

Network Reporting 
System

no yes

Inventory Reports no yes

Data Viewer yes yes

DPN Performance 
Viewer

no yes

Server Administration no yes

Service Selection yes yes

GMDR Administration no yes

Host Group 
Administration

no yes

Table 15
MDM tools and utilities in MDM Operator Client and MDM Toolset

Tool/Utility Operator Client MDM Toolset
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Nodal provisioning 
Template Editor

yes yes

MDM Database 
administration

no yes

System Log Display no

Historic Log File 
Display

no

Log Browser yes yes

Disruptive Command 
Safeguard

no yes

Change Password yes yes

UNIX Access no yes

Remote Access no yes

EPIC no yes

Command Console yes yes

Online documentation yes yes

Memory Utilization no yes

Network model shared 
memory utilization

no yes

MIB Browser no yes

Customer Data no yes

Remote Telnet 
Access

yes yes

Operational 
Commands

yes yes

Table 15
MDM tools and utilities in MDM Operator Client and MDM Toolset

Tool/Utility Operator Client MDM Toolset
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